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1 SCOPE

1.1 TYPOGRAPHIC AND NOTATION RULES

To improve legibility, some text elements are identified by specific typographic rules in according to
their tutorial purpose.

Emphasis font is applied to emphasize words which designs controls (Click on Cancel),
Fixed font is applied to expressions and texts of ASCII (C: \My documents\Path),

Terminology font is applied on expressions referenced in Terminology table.

Points out- information useful for the user. Indicates warning information.

Clarifies a detail.

risks. user’s question.

Refers to an external document.

Indicates a potential pitfall or operating @ Gives information in answer to expected
Stop and read before going on. a

C ® =

1.2 IDENTIFICATION

1.2.1 DESCRIPTION OF THE PRODUCT

Team for Capella is a collaborative solution to have several contributors working on the same model,
with the granularity as fine as a model element and diagrams.

It decouples the versioning issue which is ensured by a Source Control Management (SCM) tool from
the concurrent accesses issue.

It introduces a shared repository which is populated from the SCM tool and which enables several
users to work on the same model.

3
Versioning Team for Capella
System Server Collaboration
" Check-out E
S — ]
Check-in - - \g
3 i
Check-out -
- - ()
Checkin - > \'&]
h I
= |
Check-out -
= - )
Check-in B o A &
. SE - s
g )

Users can simultaneously edit the same Capella model without conflicts. Only modified elements are
locked, not the whole model, and other users can see in live modifications made by connected
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teammates. It is no longer necessary to split the model into fragments or to merge concurrent
modifications.

It is recommended to version exported models with a SCM tool, for instance Git. Please refer to the
Capella embedded documentation at the section Capella Guide > User Manual > Version Control
with GIT for more details.

Here is an overview of the Team for Capella architecture:

Server -

SCHEDULER
JENKINS

AUTOMATIC |::>
WEB BROWSER BACKUP DATABASE

Administrator

i : =

22
s
¢ COMMIT HISTORY/
-, MODEL CHANGES
= &
, = & A
0 ——— DATABASE REPOSITORY |:>
DIAGNOSTIC &
TEAM FOR CAPELLA CLIENT TEAM FOR CAPELLA MAINTENANCE
User, Administrator SERVER LOGS

Team for Capella is composed of three parts:
* Aserver, to manage the model repositories, and associated features (such as locks, etc.);

* An administration module, to schedule automatic backups (models, changes and database)
and trigger diagnostic and maintenance tasks;

* An add-on, packaged as an update site, to bring the multi-user functionalities on top of the
standard Capella rich client.

Team for Capella is available in 64 bits version for Windows.

Please refer to the Team for Capella embedded documentation at the section Team for Capella
Guide > Rationale and Concepts for more information

1.2.2 DEPLOYMENT MODES

Team for Capella can be deployed on different modes:

Installation Guide - Team for Capella 5.1.0
7137

This document is not to be reproduced, modified, adapted, published, neither translated in any material form in whole or in part nor disclosed to any third party. © Thales 2021



* Cloud: With the Cloud deployment mode, Team for Capella server is installed and adminis-
trated by Obeo, and Team for Capella clients are accessible through a remote desktop techno-

logy.

* On-Premise: With the On-Premise deployment mode, Team for Capella is installed and ad-
ministrated on the client’s infrastructure. The multiple ways to install/deploy Team for Capella
are described in section $3.1 - Installation Architecture.

1.2.3 APPLICABILITY

This guideline is applicable to following versions of Capella and Team for Capella:

Value name Value
AppChk [INSTALLDIR]\capella\capella.exe;
Product Name Capella x64 / Team for Capella x64

Product Version 5.1.0

1.3 DOCUMENT OVERVIEW

This document is intended for persons in charge of installing Team for Capella.
It describes the nominal installation, configuration and uninstallation of Team for Capella.

Please refer to the Team for Capella embedded documentation at the section Team for Capella
Guide for details and advanced configuration.

To read the embedded document, launch a Team for Capella client (after installation), click on the
Help menu in the top menu bar. Then click on the Help Contents button. A web page will appear with
all documentation and especially the Capella Guide and Team for Capella Guide sections.
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2 REFERENCED DOCUMENTATION

Title Version
Embedded documentation within Team for Capella 51.0
Capella Online Installation Guide 5.1.0
Capella Release Notes 51.0
Team for Capella Release Notes 5.1.0

Table 1 - Reference Documents
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https://www.obeo.fr/en/team-for-capella-releases#5.1.0
https://github.com/eclipse/capella/wiki/Release-Notes-5.1.0
https://github.com/eclipse/capella/blob/v5.1.0/doc/plugins/org.polarsys.capella.ui.doc/html/Installation%20Guide/How%20to%20install%20Capella%20and%20Addons.mediawiki

3 TEAM FOR CAPELLA SERVER INSTALLATION

3.1 INSTALLATION ARCHITECTURE

There are two main ways to install Team for Capella:

¢ Local clients:

o 1 server computer runs the Team for Capella Server and Scheduler,
o nclient computers run the Team for Capella Clients,

— Client Computer

o

—
]
-—

TEAM FOR CAPELLA

TEAM FOR CAPELLA EZZEGN
SERVER

1cP

= 9

P, IMPORTER CLIENT

Server Computer

-

= DATABASE
&=

[——

SCHEDULER SERVER

CLIENT

LICENCE SERVER

¢ Remote clients:

The same computer runs the Team for Capella Server and Scheduler and n Team for
Capella Clients (users connect to this computer using RDP). This allows to make the
exchanges between the clients and the server independent of the network’s bandwidth.

In this configuration, the client and server can either be installed on the server computer
or separated in two virtual machines. The latter is the recommended installation:

o Client and server separated in two virtual machines:

Server Computer

Recommended installation

TEAM FOR CAPELLA [EZZEG1

SERVER
Client Computer

CLIENT
VIRTUAL
MACHINE
— IMPORTER CLIENT SCHEDULER SERVER
TEAM FOR CAPELLA
END-USER CLIENT
SERVER
VIRTUAL
MACHINE

LICENCE SERVER
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o Client and server on the same server machine:

Server Computer

TEAM FOR CAPELLA 22BN

SERVER RN DATABASE

(.

— Client Computer

o

A
E‘ Remote desktop -_+. = p

e S |

IMPORTER CLIENT SCHEDULER SERVER
TEAM FOR CAPELLA
END-USER CLIENT

LICENCE SERVER

3.2 RECOMMENDED SYSTEM REQUIREMENTS

3.2.1 SERVER COMPUTER RECOMMENDED SYSTEM REQUIREMENTS

F It is mandatory to run Team for Capella Server and Scheduler on the same computer.

For successful installation of Team for Capella Server, your computer must meet the following
requirements:

* Local client installation (server side only):
o 2 GHz processor,
o RAM: 4 GB for the Team for Capella server + 3GB for the importer client
o 15 GB of available hard disk space

* Remote client installation:
o Multicore processor (2GHz)
= 2 cores for Team for Capella Server, scheduler and license server
= 1 core per running Team for Capella Client,
o RAM:
= 4 GB for the Team for Capella server + 3GB for the importer client
= 3 GB per Team for Capella Client,
15 GB of available hard disk space + 2 GB per Team for Capella Client,
2 hard drives are recommended:
= The first containing system files and software installation files
(a SSD hard drive is mandatory if more than 8 users),
= The second containing the Team for Capella Server file.

e System requirements:
o Microsoft Windows 7/8/10 64 bits
o Microsoft Windows Server 2008/2012/2016/2019 64 bits,
o Compatibility with Open JDK 14, see Capella Online Installation Guide
= Capella and Team for Capella are configured to use the JRE provided by
Capella (Open JDK 14.0.2)
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¢ Team for Capella database must be stored on a local hard drive,

e Security policies:
o Virus scanner:
= Team for Capella Server database files must not be scanned (* . db).
= In addition, it should not be activated either on Capella models files: *.aird,
* . capella, *.airdfragment, *.capellafragment and *.afm,
= The license server hosts a collection of licenses stored in several encrypted
.ols files. Those licenses pools must not be scanned.

= Periodic analyses should not be launched when users are working
(launch them at night),
o Firewall:

= At least 2 ports must be opened: the Team for Capella Server port (by default
2036) and the license server port (by default 9999),

= In addition, the Scheduler port (by default 8036) and the license server
monitoring port (8086, disabled by default).

*  The computer should be fully dedicated to Team for Capella.

3.2.2  CLIENT COMPUTER RECOMMENDED SYSTEM REQUIREMENTS (ONLY FOR LOCAL CLIENT
INSTALLATION)

For successful installation of Team for Capella Client, your computer must meet the following
requirements:

e 2 GHz processor
e 3 GB for Team for Capella client
*  Microsoft Windows 7/8/10 64 bits

*  Compatibility with Java Runtime Environment 14 (Open JDK 14.02 is provided by Capella)

*  Security policies:
o Virus scanner:
= It should not be activated on Capella models files: *.aird, *.capella,
* .airdfragment, *.capellafragment and *.afm.

Installation Guide - Team for Capella 5.1.0
12/37

This document is not to be reproduced, modified, adapted, published, neither translated in any material form in whole or in part nor disclosed to any third party. © Thales 2021



3.3 DEPLOYMENT RECOMMENDATIONS
3.3.1 NETWORK
3.3.1.1 Latency: Client and Team Server

It is recommended to provide a network with the lowest possible latency between the client and the
server: in the order of 1 to 10 ms for a round-trip.

3.3.1.2 Latency: Team server and DB server

It is strongly recommended that the Team server and the DB server are located on the same physical
server as latency between the Team server and DB server will impact greatly the overall performances
of the solution. As such the best performing deployment is achieved by using the H2 database in
embedded mode with its .db database file located on the same disk than the Team server.

If there is a requirement on the database that prevents from using H2, make sure that the latency is as
low as possible.

3.3.1.3 Network stability

VPN are not recommended (it is a latency factor) as well as other network elements that could drop
connections which are more or less inactive. As such wireless connection are also not recommended
as any loss of connectivity might lead to instability in the product and loss of data. However, if a
network element of this kind is mandatory, an SSH tunnel could be used as a workaround to avoid
client/server disconnections.

3.3.1.4 Server isolation

It is strongly discouraged to deploy the server on a public WAN. Team for Capella should be the only
way to edit the information stored in the database.

3.3.2 SCALABILITY AND SIZE OF MODELS

Scalability and performances are highly dependent on the design of the domain metamodel, the
implementation of this metamodel and the Viewpoint Specification Models. The following figures are
given with an Ecore model and the EcoreTools tooling which applies the Sirius best practices.

The minimum physical memory dedicated to the Team server is 4 GB for a deployment where the
expected model size is in the order of 300 000 model elements. The heap memory available for the
server should be increased to support bigger models: 8GB should support 600 000 model elements.

The memory usage of the clients will increase when the model which is shared among the clients
grows as such these resources might need to be increased for larger models with 8GB being expected
for models with 600 000 elements (the exact value might vary depending on the amount of information
each model element holds).

The latency of end user operations requiring a full analysis of the model increase as the model grow,
this includes: opening and closing a project, deleting model elements and representations, launching a
transformation or a code generation. Opening a project (and hence collecting the model from the
network) might take up to 1 min for a model with 500K elements.

Models having 1 000 000 model elements are the considered the upper limit for a Collaborative Server
deployment.
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A given server is expected to be used by 10 to 20 users simultaneously depending on their level of
activity.

3.3.3 DISCLAIMER

Notwithstanding what was stated previously, Team for Capella product is not warranted to run without
any error or interruption. Obeo does not make any warranty regarding the statements that are under
the chapter «Deployment Recommendationsy, this chapter is provided for information purposes.

You acknowledge and accept the risks involved in using these products which could include without
limitation, down time, loss of connectivity or data, system crashes, bad performances or performance
degradation.

3.4 INSTALLATION PROCEDURE

The date/time and the time zone of the server must be correct to make the scheduler work as
expected.

To use existing models in a new version of Team for Capella, copies of these models have to
be kept (in files format) before removing the old version. Once the new version is installed,
the migration procedure will be performed on these models.

34.1 TEAM FOR CAPELLA SERVER INSTALLATION PROCEDURE

3.4.1.1 Installation

Preparation steps:

1. Extract the archive TeamForCapella-5.1.0-win32.win32.x86 64.zip in agiven
directory. It contains a TeamForCapella directory with 5 sub-folders and 1 file:

* lic-server: contains a floating license server which allows several users to share the
same product licenses. Each license can be used by only one user simultaneously.

* scheduler: contains Jenkins and pre-configured jobs

* server: the Team for Capella server

* tools: contains some scripts and properties files

* updateSite: the Team For Capella update site for the client
e license.html

2. Download the Capella 5.1.0 bundle from https://www.eclipse.org/capella/download.html
(Windows).

Client Installation

1. Unzip Capella bundle.
2. Move the capella and samples folders into the TeamForCapella directory.
3. Resulting structure of TeamForCapella

* capella

e lic-server
* samples

® scheduler

° server
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* tools
* updateSite
4. Navigate to the tools folder and execute installTeamForCapellaInCapella.bat

The installation script will install the Team for Capella features in Capella, update the splash screen
and update some properties in capella.ini and config.ini.

It is configured by default to retrieve the Team For Capella update site in the folder:
TeamForCapella\updateSite

The -repository property can be updated in the script to reference it from another location.

This Capella client (capel1a folder) should be used only for the Scheduler jobs: it must not
be moved or renamed as its .exe files are referenced from the pre-configured jobs
(Scheduler) and scripts (tools folder).

It can also be zipped and provided to user in case of local client installation,
F see § 4.2.1 Team for Capella Client installation procedure.

In remote clients installation, you need to copy the full capella folder and rename it into
capella client. Then this client can be started on Windows Server and accessed with
Remote Desktop. If you want to install additional functionality, it will have to be done on
capella client and will not impact the capella folder.

3.4.1.2 Extensions installation

If meta-model extensions or add-ons are needed, use one of the following ways to install them:
¢ Use the Help > Install New Software... wizard if the extension are provided as update sites
e Otherwise if they are provided as dropins

o Either unzip/copy their binary files in the folder
TeamForCapellal\capella\dropins

o Or
= Unzip/copy them in any folder (it can be a shared folder between this server
installation and client installations)
= Modify the configuration file TeamForCapellal\capellal\capella.ini by
adding the following parameter, after -vmargs :

-Dorg.eclipse.equinox.p2.reconciler.dropins.directory=<ExtensionFolder>

Exactly the same extensions have to be installed on and on all clients and on the server
(capella and capella client).

3.4.1.3 Checks on environment variables

The Scheduler is now shipped with its own runtime JRE, it is nomore required to define the
JRE_HOME and JAVA HOME environment variables.
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3.4.2 HOW TO INSTALL SCHEDULER AS A WINDOWS SERVICE (RECOMMENDED)

1. Close the Scheduler command window if it has been manually launched with the
scheduler.bat script.

2. Go to the scheduler directory and launch winservice.bat as administrator,
it will install the service TeamForCapellaScheduler,

v Check the environment variables (see § 3.4.1.3) before launching winservice.bat.

3. Run services.msc from a command prompt,
the service TeamForCapellaScheduler should be visible,

4. Double click on it to open the service configuration dialog,

5. Setthe startup type: parameterto Automatic
(the service will be started with the computer),

6. Inthe Log On tab, configure the Windows account that will run the service.
This account must have correct access rights to allow the Scheduler and the Team for Capella
Server to access their data files,

7. If needed, start the service.
3.4.3 LICENSE SERVER INSTALLATION

3.4.3.1 Server installation

1. The license server is provided in the TeamForCapella-5.1.0-win32.win32.x86 64.zip
archive. After the preparation steps (see § 3.4.1.1), it is located in the folder
TeamForCapellallic-server

2. Unzip the OLS.zip archive in TeamForCapella\lic-server\OLS, the OLS folder should
contain 4 . o1s files.

3. You can choose to:
o either launch the license server from the sheduler's job License Server - Start
(disabled by default)
o or directly launch the tool using the command 1ic-server -keys ./OLS -verbose

Additional parameters and documentation can be found in the DOCUMENTATION. txt file located in

TeamForCapellallic-server\.

F The server configuration and more especially the ".ols™ files should not be modified, moved
or even accessed while the server is operating. Stop the license server before doing such
operation.
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3.4.3.2 Client configuration

In order to connect Team for Capella instances with the license server, a connection key must be used
to retrieve its address and port.

You should have received this key with the license server bundle and your .o1ls files. If not please
contact the support and provide the |IP address and port to use to connect to the machine that will host
the server in your local network.

The capella\capella.ini file has to be modified with the following line to define the configuration
of the server (after -vmargs);

-DOBEO_LICENSE SERVER CONFIGURATION=<connection key>
This must be done on all clients.

A license token is retrieved at the first connection attempt done by Team for Capella. It is then revoked
when the last connected Capella project is closed or when Team for Capella closes. This license is
verified from times to times with the server while you are using Team for Capella.

Clients are programmatically throttled and will not send requests to the server more frequently than
once every minute. This throttling means some of the client actions might have a delay before being
distributed to the server, for instance if one user stops using a given feature, 2 minutes of delay at
most can be necessary for another user to be able to get the token.

The client/server communication is request based, no connection is kept alive for longer than just a
request.

3.4.4 INSTALLATION VERIFICATION

1. If the Scheduler has not been installed as a service, launch scheduler.bat from the
scheduler folder,

F Check the environment variables (see §3.4.1.3) before launching scheduler.bat.

Once scheduler.bat file has been launched, you should get the following command
window:

2. Connect to the scheduler admin page using the default URL http://localhost:8036,
3. Check that the job server - Start has been automatically launched.
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http://localhost:8036/

Al Backup and Restore Diagnostic and Repair Server Management Templates 4

s w Name | Last Success Last Failure Last Duration
;J Importer - Clear credentials N/A N/A N/A
Q Importer - Store credentials N/A N/A N/A
@ License Server - Start N/A N/A N/A
. @ Server - List connected projects and locks N/A N/A N/A
Server - Start N/A MN/A N/A
£)  Sserver-stop N/A N/A N/A

On the scheduler main page, the job Server - Start should appear un the Build Executor
Status section:

Build Executor Status A

1 ldle
2 |dle
3 Idle
4 ldle

5 Server - Start #
w ay av % -

4. Once the server is started, it can be used to check the Team for Capella Client installations
(see the Team for Capella Client installation verification procedure in §4.2.3),

5. Launchthe Server - List connected projects and check its Console output,
6. Launchthe Database - backup jobfrom the Backup and Restore tab,

7. Stop the server using the Server - Stop job > the Server - Start job should be
stopped,

8. Stop the Scheduler by closing its command window.

3.5 TEAM FOR CAPELLA SERVER CONFIGURATION

This part describes the basic configuration of the Team for Capella Server and Scheduler.

§3.5.3 - How to Reuse previous server configuration when configuring v5.1.x server section can help
you save time when installing a new version a Team for Capella server.

3.5.1 DEFAULT SERVER CONFIGURATION

For the complete server configuration documentation, refer to the Capella client Help Contents in
chapter Team for Capella Guide > System Administrator Guide >Server Configuration

By default, the Team for Capella Server has the following configuration:

* Port: 2036,
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* Repository: repoCapella
3.5.2 DEFAULT SCHEDULER CONFIGURATION

For the complete scheduler configuration documentation, refer to the Capella client Help Contents in
chapters:

* Team for Capella Guide > Project Administrator Guide > Jenkins Configuration
* Team for Capella Guide > System Administrator Guide > Server Configuration
* Team for Capella Guide > System Administrator Guide > Server Administration

Team for Capella server embeds a Jenkins installation used as a Scheduler, its default port is:

e 8036 (to connect to Jenkins from the host running it, use http://localhost:8036).

In the Scheduler, 11 jobs are built-in and already configured:

e Server - Start : this job starts the server every Saturday at 06:00,
o This job never stops except if “Stop server” is launched.
* Server - Stop server: this job stops the server every Saturday at 05:00,
* Server - List connected projects and locks: This jobs lists:
o the opened Capella shared projects with the associated username,
o the currently locked objects classified by opened projects with user information.

* License server - Start: this job allows to manage the license server directly from the
scheduler.

* Importer - Store credentials and Importer - Clear credentials : those jobs allows to manage
the credentials used by the Importer application (store/clear from its secure storage)

* Repository - Diagnostic: this job needs a manual launch. It runs some diagnostics to detect
inconsistencies described in Team for Capella embedded documentation at the section Team
for Capella Guide > Project Administrator Guide > Jenkins Configuration

* Repository - Maintenance: this job needs a manual launch.

o ltis recommended to launch Start repository diagnostic first.

o After running the diagnostics from the previous job, it executes maintenance tasks if
some managed issues are detected.

o See Team for Capella embedded documentation at the section Team for Capella
Guide > Project Administrator Guide > Jenkins Configuration

* Projects - Import: this job is launched automatically every hour from 07:00 to 21:00 Monday
to Friday. Its purpose is to:

o Check periodically the database consistency. If the job is not able to get all projects, it
will fail and stop the server (in this case the database must be reinitialized),

o Keep a copy of projects in file format to be able to reinitialize the database if a
corruption happens.

¢ User profile - Import model: This job extracts the user profile model from the database. It is
disabled by default as the server is not configured to use this by default.

* Database - Backup: this job is launched automatically 3 times a day (07:30, 12:30 and 20:30)
from Monday to Friday. Its purpose is to do a dump of the database in a file that could be used
later to restore the database in exactly the same state (e.g.: existing locks will be restored),

¢ Database - Restore: this job is intended to restore the database from a previously backed up
database.
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The data (database files and projects) generated by Project - Import and Database - Backup jobs
are kept as build’s artefacts and can be retrieved later using the Jenkins interface (by default, 100
builds are kept for each jobs).

There are also 2 job templates to show how to create backup jobs whose result is pushed to a Git
repository.

See Team for Capella Guide > Project Administrator Guide > Jenkins Configuration or the
description of each job in the Scheduler for more details.

If you have many repositories, you ought to have as many “import projects” jobs that may
F start at the same time. So you need to configure the number of job executors.

Go to Manage Jenkins > configure systems menu if number of T4C repository have
been extended: # of executors = =nb of repo +3

3.5.3 How TO REUSE PREVIOUS SERVER CONFIGURATION WHEN CONFIGURING V5.1.X SERVER

When installing a new version of Team for Capella, some parts of the server/client configurations of
the previous version can be reused.

3.5.3.1 Procedure
* Manually import your data or launch the backups jobs.

¢ Launch the server - Stop job, terminate the License Server - Start job
or end tasks server.exe and lic_server.exe in task manager (processes sheet)

e Stop TeamForCapellaScheduler (service sheet)
* Keep the entire Team For Capella installation which contains all the file you may reuse.
* Choose among the following configuration you want to reuse

* Once installation is done, in task manager services sheet or in service.msc, restart
TeamForCapellaScheduler service if you want to restart the previous version, otherwise
see §3.7 - Uninstallation procedure to uninstall the service.

3.5.3.2 Server CDO

e Copy part of the c:\xxx\T4C\server\configuration\cdo-server.xml file which contains
o the acceptor tag can be reused

o the repository configurations can be reused except for userManager, securityManager
tags.

* if the server was configured with the authenticated configuration, the content of c:\xxx\T4C\
server\configuration\users.properties can be kept as is.

* If the server was configured with the user profile configuration, the user profile model can be
reused. Follow the steps described in Team for Capella Guide > System Administrator
Guide > Access Control > User Profiles > Import/Export User Profile Model.

* You may also consider all properties or parameters you may have set in the server.ini file.
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3.5.3.3

3.5.3.4

3.5.3.5

3.5.3.6

3.6

3.6.1

If you are doing a new installation with the same version, you can reuse the database. Copy
the C:\xxx\T4C\server\eclipse\db folder. Note that the database cannot be reused if
the Audit mode activation changes between both installations.

Scheduler

In the C:\xxx\T4C\scheduler\jenkins home folder

o config.xml contains the global Jenkins configuration which can be reused

°o  jobs\ contains the jobs definition with the build history. jobs\<xxxjob>\config.xml
can be reused modulo some parameter changes that may be needed (for example for
importer executable call).

Importer

You may consider all system properties or parameters you may have set in the importer.bat
file (or importer.ini for older versions) . That information have to be transferred and adapted

o  From C:\xxx\T4Cl4\capella\eclipse\importer.bat
o To cC:\xxx\T4C\tools\importer.bat.

Client (in remote clients installation)

You may consider all properties or parameters you may have set in the eclipse.ini file. That
information have to be transferred to c:\xxx\T4C\capella client\capella.ini.

If the IP adress of the server did not change, you can keep the
OBEO_LICENSE SERVER CONFIGURATION property system (just copy
-DOBEO_LICENSE SERVER CONFIGURATION=11616856647338552998511484....)

License server

The license server version is now provided in the Team for Capella archive.

The *.o1s files may have been thought up to be reusable for your new Team For Capella
version. In this case, you can keep your *.o1s files.

BASIC ADMINISTRATION TASKS

USER ACCOUNTS MANAGEMENT

Several modes of access control can be used for each repository on the server:

Identification (default mode): each user defined in the file user.properties is authorized to
read and/or modify all models present on the repository.

User Profiles: discriminating user rights are defined in a User Profiles model stored in the
database.

LDAP Authentication: this mode allows to authenticate with a LDAP server. It can be also used
with authenticated or with user profiles.

Not Authenticated Access: anyone can read and/or modify all models on the repository.

For the complete access control configuration documentation, refer to the Capella client Help
Contents > Team for Capella Guide > System Administrator Guide in chapters:
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* Access Control

* Server Configuration

» Server Configuration > Not Authenticated Configuration
* Server Configuration > Authenticated Configuration

* Server Configuration > LDAP Authentication

* Server Configuration > Activate SSL Connection

» Server Configuration > User Profile Configuration

In the current version, Team for Capella is configured with the “Identification” access control

!F mode, ie. passwords are not encrypted. Refer to Team for Capella Guide > System
Administrator Guide > Access Control if you need Authentication or Authorization
mechanisms.

There are two ways to manage user accounts (Identification mode) in Team for Capella:

e On Server side:
o Edit the users.properties file from the configuration folder using the following
syntax: login=password
o Example:

admin=admin
userl=userl
user2=user2
user3=user3
T123456=T123456
T654321=T654321

o If the Team for Capella Server is running when this file is changed, it has to be
restarted (using the “Stop Server” job and then the “Start Server” job) to load the new
accounts.

* On Client side:

o Use the “User Management” view available in all Team for Capella clients. When
using this view, the server does not need to be restarted after changes in the user
accounts.

3.6.2 HoOw TO START THE SCHEDULER
There are two ways to launch the Scheduler:

* As a Windows service, see §3.4.2 - How to install Scheduler as a Windows Service
(recommended).

* As a classic process (not recommended):
o Launch “scheduler.bat” in the Scheduler folder
(<TeamForCapellaInstallationFolder>\scheduler\scheduler.bat),
o This method is not recommended because if the user running the Scheduler logs off
or if the computer is restarted, the Scheduler will not be started automatically,
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3.6.3 HOW TO START THE SERVER WHEN SCHEDULER STARTS

To start the Team for Capella Server automatically when the scheduler starts (i.e.: launch the start
server job), go to the configuration page of the Start server job and then check the box “Build
when job nodes start”, the “Quiet period” parameter allows to delay the start:

General Source Code Management Build Triggers Build Environment Build Post-build Actions

[ Build after other projects are built
Build periodically
Schedule

06**6

Would last have run at Saturday, April 24, 2021 6:00:27 AM CEST: would next run at Saturday, May 1, 2021 6:00:27 AM CEST.

(& Build when job nodes start )

Restricted node Label

Quiet period

60

3.6.4 How TO CHANGE JOB SCHEDULING

Every job contains in its configuration page a text field called “Schedule”. Use this field to change the
Job’s scheduling configuration.

It is visible on the previous screenshot.
3.6.5 HOW TO STOP THE SERVER

The main methods to close the server are the following:
* Launch the dedicated Scheduler job: Server - Stop (recommended method),
e If Jenkins has been stopped, use the OSGI console :

o telnet localhost 12036
o atthe osgi prompt: close

To avoid database corruptions, the server must in no way be closed these ways:

* Using the “Abort” button on the Server - Start job of the Scheduler,
e Especially on Windows 2008 Server 64 bits platforms:
v o Closing the command prompt running the server (if any) by clicking on the
Windows close button,
o Leaving the server close when the user logs out or the computer stops (to
avoid this problem, it is advised to launch the Scheduler as a service so the
server is not closed on log out).

3.6.6 How TO STOP THE SCHEDULER

* If the Scheduler was launched as a classic process (scheduler.bat), the opened command
dialog can be closed,
e [f the Scheduler was launched as a Windows service,
* open the service configuration dialog (see §3.4.2 - How to install Scheduler as a Windows
Service (recommended) and click on “Stop”,
* An alternative method is to use the command: scheduler.bat stop.
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3.6.7 HoOw TO RESET THE SERVER
To restart with a clean server or after a database corruption, it can be useful to reset the server:

1. Stop the server using the Scheduler,

2. Remove the folder workspace from the server folder,

3. Remove the folder db-auditing from the server folder (value for the default repository,
check the dataSource elements of your cdo-server.xml file).

4. Start the server,

5. Export the needed models from a Team for Capella Client
(using the “Import Job” result artifacts for example).

Note that it is also possible to restore the database from the result artifacts of the Database -
Backup job, refer to the Capella client Help Contents in chapter Team for Capella Guide > System
Administrator Guide > Server Configuration > Reinitialize database.

3.7 UNINSTALLATION PROCEDURE

To uninstall Team for Capella:

Do a backup of projects stored on the Team for Capella Server,

Stop the server (see How to stop the Server),

Stop the scheduler (see How to stop the Scheduler),

If a Windows Service was created, remove it:

Using a Windows Command Line (as administrator), go to the scheduler directory,

Execute the following command: sc delete TeamForCapellaScheduler

(alternative command: modify the winservice.bat to comment the installation steps and
uncomment the uninstallation steps).

7. Remove the installation directory.

o0k wN -~
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4 TEAM FOR CAPELLA CLIENT INSTALLATION

4.1

4.1.1

REQUIREMENTS

RECOMMENDED SYSTEM REQUIREMENTS

For successful installation of Team for Capella Client, your computer must meet the following
requirements:

4.2

4.2.1

2 GHz processor

3 GB for (for big models, 4GB RAM)

Microsoft Windows 7/8/10 64 bits

Compatibility with Java Runtime Environment 14 (Open JDK 14.02 is provided by Capella)

Virus scanner should not be activated on Capella models files: *.aird, *.capella,
* .airdfragment, *.capellafragment and *.afm.

INSTALLATION PROCEDURE

TEAM FOR CAPELLA CLIENT INSTALLATION PROCEDURE

You may take your Team For Capella client as it has been installed for the server installation. In that
case, you simply need to make an archive of the capel1a folder and distribute it to users.

™

™

Before archiving the Capella client that will be deployed on others computers, don't forget to
remove the workspace used for the installation from the recent workspaces list (Window >
Preferences > General > Startup and Shutdown > Workspaces).

It is also possible to manually install Team for Capella but note that the installation with the
tools/installTeamForCapellaInCapella.bat isrecommended.

Manual Team for Capella installation:

Extract the archive TeamForCapella-5.1.0-win32.win32.x86_64.zip and keep only the
updatesSite folder.

Download and unzip Capella 5.1.0 bundle (Windows, https://www.eclipse.org/capella/download.html)

Launch Capella (capella.exe)

Click Menu Help/Install New Software... , add the archive file in the updatesite folder and
select features in the Team for Capella category.

Then you need to do the additional tasks performed by the installation script:

Installation Guide - Team for Capella 5.1.0

25/37

This document is not to be reproduced, modified, adapted, published, neither translated in any material form in whole or in part nor disclosed to any third party. © Thales 2021


https://www.eclipse.org/capella/download.html

* (optional) tochange the splashscreen:in capella\capella.ini replace the value

of osgi.splashPath by
platform\:/base/plugins/com.thalesgroup.mde.melody.collab.ui

6. Add the license server configuration key as described in §3.4.3.2 - Client configuration.
Steps 4 and 5 are done by the installation script.
4.2.2 TEAM FOR CAPELLA CLIENT CONFIGURATION

For the complete client configuration documentation, refer to the Capella client Help Contents in
chapter Team for Capella Guide > User Guide > Client Configuration > Client Preferences

1. Launch Team for Capella (“capella/capella.exe”),

2. Optional: clean the user’s Secure Storage (it contains the save Login/Password, if “Remember
Me” option was used):
a. Go to menu Window > Preferences > General > Security > Secure Storage,
Open the “Contents” tab,
Select “[Default Secure Storage]’,
Click on “Delete”,
Upon request, restart the Team for Capella client.

©®oo o

3. Go to the menu Window > Preferences > Sirius > Team collaboration
a. Set the server location with the hostname or the IP address of the Team for Capella
Server (localhost if the server is setup on the same machine),
b. Click on “Apply”

4.2.3 VERIFICATION INSTALLATION PROCEDURE

1. Create a new project 2 Right click in the Capella Explorer > New - Capella Project
a. Callit Test for example = Finish

2. Export the project to the remote repository
a. Right click on the project > Export > Team for Capella > Export model to remote
repository>Next,
b. (Optional) Expand Connection Information if the deployed repository with default
parameters
c. Click on Test Connection,

== Export Project to Repository O X

Export Project to Repository

Select a repository to connect

Repository: | Default ~

» Connection Information

Test connection | [ Repository connection must be tested.

@' < Back Mext » Finish Cancel
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d. Provide the user name and password (by default: user1/user1, user2/user2,
user3/user3, admin/admin) > See chapters Default Server Configuration and User
Accounts Management to customize users/passwords,

e. Click on Finish.

3. Connect to the remote project previously exported,
a. Right click in the Capella Explorer > New - Connect to remote repository,
b. Test Connection,
c. Select the Shared project from the list,

= Connect to Shared Project O X

Connect to Shared Project
Select the Shared Project to Connect to

Shared Project to Connect to:
Jtest/test.aird ~

Local Project Name:

| test.team

Use default location

Location: | E/Dev/5.0/TeamForCapella/capella/workspace/test.team Browse...
® < Back Mext = Cancel

d. Click on Finish,

4. You should now be able to work on the project on the remote repository.
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5 RELEASE NOTES

The Team for Capella 5.1.0 release notes are available at:

https://www.obeo.fr/en/team-for-capella-releases - 5.1.0
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6 MIGRATION OF EXISTING PROJECTS

6.1 VERSION COMPATIBILITY

Team for Capella (based on) Capella (third party software) Sirius
1.0.3 (32bits & 64bits) 1.0.3 Sirius 3.1.6
1.1.4 (32bits & 64bits) 114 Sirius 4.1.9
1.2.2 (64bits) 1.2.2 Sirius 5.1.4
1.3.2 (64bits) 1.3.2 Sirius 6.1.4
1.4.0 (64bits) 1.4.0 Sirius 6.3.0
1.4.1 (64bits) 1.4.1 Sirius 6.3.1
1.4.2 (64bits) 1.4.2 Sirius 6.3.3
5.0.0 (64bits) 5.0.0 Sirius 6.4.0
5.1.0 (64bits) 5.1.0 Sirius 6.5.0

Table 2 - Version Compatibility (sorted by delivery dates)
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6.2 MODEL MIGRATION FROM PREVIOUS VERSION TO V5.1.X

To use a previous version model in Team for Capella v5.1.x, a migration must be done to be compliant
with the new metamodel and file extensions. This model migration is provided by Capella and must be
done between each minor version (from v1.3.x to v1.4.x for example).

The process to migrate a model to v5.1.x from a shared repository follows the following steps:

0) If Team for Capella users have created local diagrams (i.e.: diagrams stored in the local .aird
file), they have to move all diagrams they want to keep to a remote .aird or
.airdfragment (“Move Diagrams” action),

1) Import locally the model to migrate (“Import model from remote repository”) using previous
version (v1.4.x or v5.0.x) of Team for Capella. Make sure that associated team server is
running before importing from remote repository. Another way is to use the last valid import of
the Scheduler.

= Make a baseline of the imported model,

2) Migrate the previously imported model (“Migrate Project toward current version”) in a Team
for Capella v5.1.x. (The migration can also be done in Capella v5.1.x). To do so, please refer
to Migration dedicated chapter of Capella online installation guide,

= Make a baseline of the migrated model,

3) Export the migrated model to the Team for Capella server v5.1.x (“Export model to remote
repository”) using Team for Capella v5.1.x. Make sure that associated team server is running
before exporting to remote repository.

After performing these steps, the model in the shared repository is in right version. Team for Capella
has to be upgraded on client’'s computers. Then users can connect and work on the model. They do
not need to do any migration.

6.3 MODEL MIGRATION FROM AN OLDER VERSION

The model migration is necessary between each version considering only minor and major version
change.

* For the first model migration, you need to reproduce only steps 0, 1 and 2 described above.
* For the following intermediary model migrations, you need to reproduce only step 2.
* For the last model migration, you need to reproduce only steps 2 and 3

For example is you start from v1.2.2 model

* do steps 0,1 and 2 with previous version = 1.2.2 and new version = 1.3.2,
e do step 2 with previous version = 1.3.2 and new version = 1.4.2,
e do steps 2 and 3 with new version = 5.1.0.
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7 PERFORMANCE CONSIDERATION FEEDBACK

This chapter will provide you some useful information about the performance you should expect and
about performance on production context (with big sized model and many users)

7.1 REFERENCE TIME

You may wonder, if the performances you have are normal, that is, if the time elapsed, when doing
usual action in Team for Capella, is the right one compared to what should be expected.

Ensuring that the elapsed time doing your actions is the expected one, will help you to ensure that
there are no issues that could come from other cause like network lag, lack of memory, antivirus
process etc..

7.1.1 CASE STUDIES
Some studies have been done on reference Capella models:

e The open source IFE model packaged with Capella
* Combined IFEs, a modified version of IFE which is artificially swollen to have an important
sized model.

The next figure presents some characteristics on those models and the expressions used to compute

them.
Project
Characteristics FE Combined
IFEs

File (size in KB)
Project 19179 203 310
.capella 1475 13 464
.aird 17 705 189 846

Model (number of elements) AQL expressions to use in Interpreter view

aql:self.eAllContents()->size()

5378 49 389
Capella elements select the first child of the .aird file in the Project Explorer

agl:self.eAllContents(cs::Component)->size()

110 1230
Components select the first child of the .aird file in the Project Explorer
_ 204 2 652 agl:self.eAllContents(fa::AbstractFunction)->size()

Functions select the first child of the .aird file in the Project Explorer

_ 111 880 agl:self.eResource().getContents()->filter(diagram::DDiagram)->size()
Diagrams select a diagram in the Project Explorer
Tabl 1 8 agl:self.eResource().getContents()->filter(table::DTable)->size()

ables

select a diagram in the Project Explorer
. aql:self.eResource().getContents()->filter

Elements dis- 6 384 70 850 (viewpoint::DRepresentation).eAllContents (viewpoint::DRepresenta-
played in all rep- tionElement)->size()
resentations

select a Diagram in the Project Explorer (only for local projects)
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Table 3 - Reference models

Refer to See §7.3 - How to get characteristics of your model to see how to get the characteristics of
your own model in order to compare it with those reference models.

7.1.2 MEASURES

Measures contained in this document give some idea and order of magnitude of the performances
expected for comparable environments.

They have been taken on two different deployments:

* Local: single computer with both client and server - IFE and Combined IFEs
¢ OVH: two virtual machines, one for the client and one for the server as recommenced in §3.1 -
Combined IFEs.

7.1.2.1 Computer used for the tests

Local Windows computer

Edition Windows

Windows 10 Famille

ml \\/
% 2019 Microsoft Corporation. Tous droits réservés. .- WI n d OWS 1 0

Systéme
Processeur : Intel(R) Core(TM) i7-4700HQ CPU @ 2.40GHz 2.40 GHz
Mémaoire installée (RAM) 8,00 Go (7,89 Go utilisable) .
Type du systéme : Systéme d'exploitation 64 bits, processeur x64 eaplig Wncvuion Parsios Paesive
OVH Windows computer
Windows edition
Windows Server 2016 Standard
© 2016 Microsoft Corporation, All rights reserved. ==_ Windows Server 2016
System
Processor: Intel Core Processor (Haswell, no T5X) 2.39 GHz (4 processors)

Installed memory (RAM]): 14,6 GB
Systern type: 64-bit Operating System, x64-based processor

7.1.2.2 Reference elapsed time

The memory allowed to the Team for Capella client can be configured with the capella.ini file beside
capella.exe executable.
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7.1.3

IFE Combined IFEs
Elapsed time (s)

Xmx 3GB Xmx 3GB
Export To Server 28,7 114
Open Session (first time) 3,7 9
Test Close Session 1 3
Open Session 2 6,5
Open the diagram (1) 4 6
Create a LFBI_I) diagram 3 6
on Root Logical Function. (2)

Save the session after steps from (3) 2 7
Test Close Session 1 3
Test import local for remote 9 122 (4)

(1) Open [PAB] [BUILD] All Pcs, Pfs, Fes .
It is a diagram containing 486 DRepresentationElement for both /FE and
Combined IFEs.
(aqgl:self.eAllContents (viewpoint::DRepresentationElement)->size())

(2) The created diagram will contain 121 DRepresentationElement for /FE and484
DRepresentationElement for Combined IFEs.

(3) Steps to do before save: Save Session + Transition a LF from Logical layer to
Physical Layer (with Apply) + create a PFBD on root PF

(4) This used to require 4GB of Ram with 1.4 stream to be in success

ANALYSIS AND CONCLUSION

The majority of the scenarios could be done with the minimum recommended memory of 3Go.

Nevertheless, with model of big size (Combined IFEs ), we need more RAM to work with constant
performance for some actions like Refresh all representations or Validate on the whole model.

If the Team for Capella Client reaches, at execution, the maximum allowed memory, the performance
may drastically fall particularly for actions that consume a lot of memory such as:

Import a Capella project locally from the server

Do the Validation of the whole project

Start Refresh All Representation action

Save if many objects have been changed or deleted

Some particular Capella functionality such as functional transition
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7.2 DEDICATED TESTS ON COMBINED IFES

The aim of this test session was to ensure that Team for Capella is able to have to keep the right
performances after having used for a while.

e Combined IFEs is used as the Capella Project. It is a large sized project.
e 20 users are connected to the Capella project on the server
e 8 users are really working on the model. During the test, they will do standard actions such as
o Open many diagrams
Create, Refresh, modify diagrams
Make functional transition for some of them
Regularly create semantic element through diagram or not
Use tool in diagram palette
Use the Activity Explorer, F8 and F9 to navigate
o Validate some parts of the model
But also, other actions that demands significant amount of RAM

0O O O O O

* The tests have been done with 21 virtual machines hosted on OVH cloud (20 clients and 1
server):
o Client Xmx=3Go
o Server Xmx=4Go

7.2.1 SERVER

Throughout the test, the server never reaches its maximum allowed memory of 4Go RAM and not
even 3Go. It keeps constant performance.

7.2.2  CLIENT
The client behaves constantly with good performance throughout the tests.

Nevertheless, the client may reach 3Go of memory if high memory consumption actions are performed
such as:

e Import a Capella project locally from the server
* Do the Validation of the whole project
* Start Refresh All Representation action

Once the maximum allowed memory is reached:

* The user keeps having good performance for standard actions
* But the performance may fall drastically for high memory consuming actions. For that cases,
the performance issue can be solved
o using more allowed memory for the client (Xmx=4 or more)
o simply restarting the client

Note that the potential performance issue encountered by one user has no impact on another user
7.2.3 CONCLUSION

The model used is what we consider as a medium-big sized model.
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20 users are working on it.

* The server 4Go is well fitted for the use
* The client 3Go RAM is sufficient for most cases. It can be increased to have best performance
when the user uses high memory consuming action

7.3 HOW TO GET CHARACTERISTICS OF YOUR MODEL

The simplest way to get characteristics of your model is to use the Sirius Session Details tab available
in the Properties contextual menu of the .aird file of your project:

== Properties for TestProject.aird [m| *
Sirius Session Details v §

Resource
*** Date: Thu Apr 29 23:24:00 CEST 2021 A

Sirius Preferences

Sirius Session Details *#*% Racources

Session Resources (1)
platform: /resource/TestProject/TestProject.aird - 27 elements - 8448 bytes

semantic Resources (2)
platform: /resource/TestProject/TestProject.afm - 2 elements - 347 bytes
platform: /resource/TestProject/TestProject.capella - 96 elements - 22047 bytes

*** Viewpoints

Active viewpoints (7)
System Analysis loaded from resource platform:/plugin/org.polarsys.capella.core.si
Common loaded from resource platform:/plugin/org.polarsys.capella.core.sirius.anal
EPBS architecture loaded from resource platform:/pluginforg.polarsys.capella.core.:
ad loaded from resource platform:/plugin/org.polarsys.kitalpha.ad.integration.siri
Physical Architecture loaded from resource platform:/plugin/org.polarsys.capella.c
Operational Analysis loaded from resource platform:/plugin/org.polarsys.capella.col
Logical Architecture loaded from resource platform:/plugin/org.polarsys.capella.col

Inactive viewpoints (@)

< >

Copy to Clipboard

® Cancel
= Properties for TestProject.aird [m] X
Sirius Session Details =l =T
Resource
*** Representations A

Sirius Preferences
Sirius Session Details

All representations: 1
Diagram: 1
Sequence: @
EditionTable: @
CrossTable: @

Tree: @

Loaded representations: 1
Representation elements in loaded representations: 1

Loaded representations containing elements with no semantic target (red cross decora
Tip: The next (manual or automatic) refresh will remove those elements. The red cro:

Invalid representations (@)

Information: A representation is invalid when:
- it has no target represented element or its target element has been detached or .
- it can not be reached because it has been deleted or because of a technical issw

Representation descriptors details (1)
[LCBD] Structure - uid: _FebwAKkxEeuaoek9LKk34w - description: Logical Component Bi

Representations opened in an editor (1)
[LCBD] Structure - uid: _FebwAKkxEeuaoekILKkI4w

< >

Copy to Clipboard

Cancel

@ [Appty and o
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On shared projects, the Collaborative Session Details tab gives information about connected users

and locks:
== Properties for TestProject.team.aird m} X
%] | Collaborative Session Details T d
Resource - = Server location: localhost
Collaborative Session Detail
5 Port number: 2036
Sirius Preferences ;
Siriss Session Details Repository Name: repoCapella
Connected as: userl

Other connected users: userd

Connected project information

Connected user: userl

Objects locked by current user
Implicit {eClass: ctx::CapabilityPkg, name: Capabilities2.*, id: 2c36586e-4e23-4604-b528-57fdf377cba2}
Explicit {eClass: ctx::SystemAnalysis, name: System Analysis, id: e5b39cd3-d55c-4ea4-b584-b273728a2369}
Explicit {eClass: ctx::SystemFunctionPkg, name: System Functions, id: f32efedl-7f77-4b87-b@4a-beb3545b728b}
Explicit {eClass: ctx::SystemFunction, name: Root System Function, id: e@@56828-3c51-4582-9d88-66a659ec29f3}
Explicit {eClass: fa::FunctionRealization, id: @bfbc23b-3826-47e5-817a-c24f57cbbble}

Objects locked by other users (for loaded resources)
{eClass: la::LogicalArchitecture, name: Logical Architecture, id: @a6l6a48-ccfc-4bla-9808-a35cfd68355T}

Copy to Clipboard

® Apply and Close Cancel

It is also possible to additional model characteristics thanks to the Interpreter view:

[ Properties | i- Information | 3# Semantic Browser | < > Interpreter 52 = O
<> Sirius interpreter ~ Result of type Integer @ = O
Expression B 5

aql:self.eResource().getContents()- > filter (viewpoint:DRepresentation).eAllContents (viewpoint:DRepre

£ >

Evaluation Result laz "

13 6334

To get the characteristics of the .capella semantic resource :

¢ select any semantic element

w (= In-Flight Entertainment System
[5§ In-Flight Entertainment System.afm
~ [ In-Flight Entertainment System.aird
~ %21 In-Flight Entertainment System

* write the AQL query in the Interpreter view to get the result in the lower part of the view.

To get the characteristics of the representations in the .aird
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* select any representation

~ [== In-Flight Entertainment System
{74 In-Flight Entertainment System.afm
w || In-Flight Entertainment System.aird

%21 In-Flight Entertainment System

w [ Representations per category
v = Common

w | | Class Diagram Blank
&= [CDE] In-Flight Entertainment Dictionary
write the AQL query in the Interpreter view to get the result in the lower part of the view
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